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Chapter 2 – The Design Window 

Chapter 2 Objectives 

 
 Learn about Crystal sections 

 Move objects 

 Use Toolbars, Icons, and Menus 

 Format fields 

 Add Special Fields 

 Change a Group 

 Use the Crystal Field Explorer 

 Create Text Objects 

Scenario for Workshop 2 

9:00 AM Monday.  You created a report for I. M. Bossy, but it doesn’t look good enough to 
present at a Board of Director’s meeting. You call Databaseman for help.   

 
 

  
 
 

Databaseman says you should first become familiar with the Design Window, sections, 
toolbars and menus.  

“Now you need to use the Design Window to clean up the 
formatting of your report.” Databaseman tells you. 
 
“You will then need to format the ANNUAL_SAL with 
dollar signs. And add a Title, Text Objects, and other 
Special Fields to your report.”  
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Workshop 2:  Move Field, Format Currency, Add 
Special Fields, and Text Object 

In this workshop you will use toolbar icons, pulldown menus, or right-click menus to format 
fields, add special fields, or text objects.  You will move fields from one section of the report 
to another, and expand a section to hold more fields.  When you are finished your report 
should look like this: 

 

You can move fields in the Preview Window or Design Window. The Preview Window 
shows your changes immediately.  However, if you have a long or complex report, using the 
Preview Window for formatting fields will be slow.   

In this chapter we shall use the Design Window to move and format fields, and the Preview 
Window to check our results. 

 First use File | Save As to save your Crystal_Wizard.rpt as 
Employees_by_Region.rpt.  This way you will not overwrite your 
first report when you make changes to it later in this workshop. 
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Design Window 

With the report you did in Workshop 1 open, click on the “Design” tab.  You will see the 
Design Window shown below. 

 

 

 

 

 
 
 
 

The Title Bar contains the name of the program, the name of the report, and the standard 
Windows (minimize, maximize, exit) buttons. 

The Menu Bar has drop-down menus, some of which contain sub-menus.  These menus and 
sub-menus contain all the actions you need to create a report.  At times the choices are 
several menus deep. For a detailed description of all toolbars and menus, see Appendix B.  

The horizontal and vertical Ruler Bars aid in the layout of your report and allow you to place 
fields at specific positions in the report. 

The Design Window is the main work area that consists of multiple sections for inserting 
database fields and objects in your report.   

Standard 
Toolbar Experts 

Toolbar 
Guidelines 

Title 
Bar 

Sections 

Formatting 
Toolbar 

Insert 
Toolbar 

Ruler Bars 

Design 
Window 

Menu 
Bar 
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Crystal Sections 

Any report can be divided into many horizontal sections. You may not need them all. Her are 
the names of the sections and what they do. 
 

Section 
Name 

Sequence 
in Report 

When and How Often Line(s) 
 are Printed 

Typical Usage 

Report Header 1 Once per report while processing the first 
record 

Cover page for the 
report 

Page Header 2 Once per page while processing the first 
record of a page 

Column headings, date 
and page number 

Group Header 3 Once per group while processing the first 
record of the group  

Group names (s) 

Details 4 Once per record Detail information for 
each record 

Group Footer 3 Once per group while processing the last 
record of the group  

Group subtotals 

Report Footer 1 Once per report while processing the last 
record 

Grand totals 

Page Footer 2 Once per page while processing the last 
record of a page 

Footnotes, authorship 
notes, page numbers 

Sections can be hidden or suppressed, however their order cannot be changed. All sections, 
except Group Header and Group Footer, are present in all Crystal reports. Every Header 
section has a corresponding Footer section. The Details section is the only single section. 

Groups are optional. You can have no group, one group, or several groups. For each group in 
your report, Crystal inserts a Group Header and Group Footer. This report has one group, 
REGION. Therefore there is a Group Header #1 section and a Group Footer #1 section. 
Crystal calls the data in the Group Header #1 and Footer #1, the Group #1 Name. In this case 
it is the number of the REGION for which the details are grouped. 

A section can be as large or as small as you want it to be.  You can re-size any section by 
grabbing the thick gray line that separates the sections and moving it up or down.   

You can suppress a section so it will not preview or print (more later). Suppressed sections 
are displayed with hash marks in the Design window. 

Each section’s characteristics define where it is activated, where it prints on the page, and 
how often it is printed.   The name of the section area is always displayed in the Design 
screen and a shortened version of the section name is displayed in the Preview window. 

It is easier to understand Crystal's use of sections by remembering that Crystal only "sees" 
one record at a time. Crystal knows which sections to print by the relative position of the 
current record in relation to all the records in the table. 
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Using Guidelines 

Crystal provides guidelines to help you accurately place objects in your report. Guidelines 
are non-printing dash lines that you can place anywhere on the rulers of the Design and/or 
Preview windows to assist in horizontal and vertical alignment. They have a snap property, 
which automatically anchor the objects to a guideline. You can turn Guidelines on or off in 
Options. 

 Select File | Options | Layout (This is the only way to open  
Options.) 

 

 Check Guidelines under Design View.   

 Guidelines in Preview can be distracting.  If you want to see them 
there, check that box too. Otherwise leave it unchecked. 
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 Click OK to close the Options dialog box.   

Even though Display Group Tree is checked, once the Group Tree is toggled off in a report it 
will not be displayed in that report until toggled back on.  Options are discussed in detail in 
Appendix B. 

Guidelines are now visible in the Design window. 

 

 
 

 

 

 The arrowhead indicates a guideline has been set and the dash line 
shows when fields are anchored to it. 

 To anchor an object, move the object to the guideline, NOT the 
guideline to the object. 

Red dots anchor guideline to 
objects.  
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Problems with Guidelines 
 

What Happened How to Fix 

Wrongly dragged a guideline off 
the ruler and now the guideline is 
gone. 

Click the Undo button, which will undo the 
guideline.  If you noticed it later, just add 
another guideline and anchor the objects as 
described below. 

Guidelines do not move with 
objects. 

You detached the objects from the guideline. 
To anchor an object, move the object to the 
guideline until red dots appear at the corners. 

When you move a guideline the 
objects stretch instead of move. 

The object has been snapped on the left AND 
on the right. Resize the object away from one 
of the guidelines, and then move the object. 

Multiple guidelines, which are 
not being used, are showing on 
the ruler. 

Remove unnecessary ones by dragging them 
off the ruler. 

Object does not anchor to 
guideline 

Move the object to the guideline, not the 
guideline on the ruler. 

 

Moving & Resizing Fields 

When you insert a field into the Crystal Design window, the program creates a placeholder 
box that is equal to either the size of the field label or the size of the field itself, whichever is 
larger. You can move the field with your mouse or the arrow keys. You can change the shape 
of the placeholder box. 

Moving a field 

The report wizard placed the REGN_DESC field in the Details section. As a result, it is 
repeated for each record. The report would be more attractive if this field was moved to the 
Group Header #1 section.  This is very easy to do.  

 Click on the REGN_DESC data field (in Details section, not heading 
field with same name). When you see the frame outline, your cursor 
should become a four-way arrow.   

 Drag the REGN_DESC into the Group Header section.  
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You can also move fields with the keyboard arrows.  

 Select one or more fields by: 

 Clicking on a field 

 Holding down the Control key and clicking on additional 
fields, or 

 “Lasso” a group of fields by holding left mouse button, 
dragging mouse over several fields, and releasing the button. 

 Press the keyboard arrow to move field(s) in the direction you want 

Deleting a field 

You can delete an object by selecting the field and then clicking on the Cut  icon, or 
selecting the field and touching the Delete key.  

 Delete the REGION field from the Details Section (not the Field 
Title, which is in the Page Header section). What happens to the Field 
Title? 

 Click the Preview tab to see how these changes affected the report. 

If you change your mind after deleting a field, you can always click the Undo button . 
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Cutting and pasting a field 

You need to switch the vertical positions of the NAME field and heading with the 
REGN_DESC field and heading.   

 Select NAME in the Details section and click on the Cut icon. 
The field is cut and the heading is deleted. 

 Select the REGN_DESC field (in the Group Header section) and 
slide it to the left. 

 

 Both the heading and field will move together.  

 Now click on the Paste icon, and move your cursor back into the 
Design Window. 

 You will see a rectangular object connected to your cursor. Place this 
in the Details section to the right of REGN_DESC, and click the left 
mouse button to anchor. 
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Copying a field 

You can also copy an object from one point to another by using the Copy icon and then 

the Paste icon. 

You can use the keyboard commands of Control plus the “C” key to copy or Control plus 
the “X” key to cut, and Control plus the “V” key to paste. 

Stretching a field 

The Region Description is cut off.  You can fix that by stretching the object.  

 Click on the field to show the frame. Notice the dark dots on each 
side. 

 

 Put your cursor over the right-side dot until it turns into a double-
sided arrow.   

 Then stretch the field by holding the left mouse button down and 
pulling the arrow to the right.  
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Working with Text Objects 

Everything in Crystal is an object.  Every object has properties. Properties can be viewed and 
adjusted by right-clicking on an object. The data fields, the headings associated with the data 
fields, lines, boxes, charts, etc. are all considered objects.  An object's properties can be 
activated or de-activated conditionally. Properties specify the way the object is formatted or 
displayed. 

First you want to change some of the Field Headings inserted by the Wizard, because they 
look too much like field names from the database (which they are). You want them to look 
like proper headings.   

 In the Design window double-click on the REGN_DESC heading in 
the Page Header section.   

Because this is a text object, your cursor will be placed inside the object 
frame. Your cursor will become a flashing vertical line in front of the text in 
the frame. It may be difficult to see this, but hit the space bar a couple of 
times and you should see REGN_DESC move to the right.  Now you can 
insert new text, delete some of the text, or type over the text in the object. 

 Change REGN_DESC to REGION DESCRIPTION.  

 Do not hit the Enter key. This will put another line into the text box.  
Click your mouse outside the text box to finish. 

 Stretch the text box to show the whole heading.   

 When you cut and pasted the NAME field, the NAME heading was 

deleted. Click on the Insert Text Object  icon. Use the cross-hairs 
to draw a text object over the NAME field.   

 Type EMPLOYEE NAME in the text object box. Click outside the 
box to finish. 

 Double click on ANNUAL_SAL heading and change it to ANNUAL 
SALARY.   

 Resize the text box to see the whole heading. 

 The heading over the GENDER field takes up more space than 
necessary for the field.  This isn’t a problem in a small report but 
could be in a bigger report.  Shorten the GENDER heading to M/F. 
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Formatting Text Fields 

Formatting a text field is the same as formatting text in MS Word or similar word processing 
applications.  Use the icons on the Format toolbar to change the font, font size and attributes 
(bold, italics, underline): 

 

 Change the font (pick one)  

   Change the font size (pick one) 

   Increase (left) or decrease  (right) the font size 

  Make a field bold, Italic, or underscore. 

 Align the content of an object within its object box: 
left, center, right, or justified, respectively. This does 
not change alignments between margins. 

 

 Click on the Preview tab to preview the report again.   

Do the Field Titles look OK?  Do any of them need to be resized?  Remember how to do that 
(stretch the dots on the object frame). 
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Formatting Number Fields 

You need to add dollar signs to the Annual Salary field.  You may also need to change the 
number of decimal places or add a comma separator for thousands.  

 Click on the field you want to format. In this case ANNUAL_SAL in 
the Details section. 

 Right click the mouse button and choose Format Field from the 
floating menu, or  

 Select Format | Format Field from the Menu Bar, or 

 Click on the Format icon on the Format Toolbar. 

You will get the Format Editor window shown below. The Number tab is 
displayed because you selected a numerical field. 

 

 Click on Display Currency Symbol checkbox.   
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When you do, you will get a choice of “Fixed” or “Floating.”  Fixed puts the 
currency symbol, in our case a $, in a fixed position at the far left of the 
number.  Floating puts the $ next to the first digit in the number.  The 
Sample box at the bottom will show you the format.   

 Change the Style in the window, and see how it changes the display 
in the Sample box.   

 For even more customization, click the Customize Button. 

Customize Numbers 

You can customize your numbers by clicking on the Customize button. This opens the 
window shown below. 

 

The table on the next page describes all the options in this window. 

These buttons 
are for 
conditional 
formatting. 
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Number Formatting Properties 

 

Number Property What it does 

Use Accounting Format  Displays a Negative Symbol as either a minus sign or brackets 
depending on Windows Regional Settings. 

Suppress if Zero Print nothing rather than the number zero. The field is still available 
for calculations. 

Decimals Sets the number of decimals (1 to 10) to be displayed.  This is not the 
same as rounding. 

Rounding Formats the number of decimals to which the number will be 
rounded.  This can be the same as or different from the number of 
decimals displayed. 

Negatives Controls the way that negative numbers will be displayed.  The minus 
sign can be positioned before the number, after the number, or the 
number is enclosed in parentheses. 

Reverse Sign for Display Changes the sign for debit and credit amounts. 

Allow Field Clipping Determines the overflow display for the object. When checked, the 
value will cut off the extra digits of numbers too long to print within 
the field (example 1.11 for 1111.11).  

When unchecked, the value will be displayed as a string of pound (#) 
signs (example ### for 1111.11). 

If field size is too small for whole amount, either resize it or select 
Can Grow property on the Common tab.  

Decimal Separator The character used to indicate a decimal separator. 

Thousands Separator Determines whether the thousands separator should be displayed.  
The Symbol box is used to indicate the character used as the 
thousands separator. 

Leading Zero Uses leading zero for values under one, i.e., 0.45 vs. .45. 

Show Zero Value As Options are default, minus sign, or zero. 

 

Global Settings 

You can set these defaults globally, for all reports, by using File | Options | Fields from the 
Main Menu.  Changing global settings will affect new objects in your report, but is not 
retroactive to existing objects. The Options Dialog box is described in detail in Appendix B. 
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Formatting Numbers from the Toolbar 

Crystal 11 has formatting icons for numbers and currency on the toolbar, so you don’t even 
have to open the Format Editor.  

 

You can click on $ to add the currency symbol, the comma to add the thousands separator, 
the % to add a percent sign, and increase or decrease decimals. When you are in the Design 
or Preview Window, you can select any numeric field and easily tell how it is formatted by 
seeing which icons are selected on the toolbar.  

 

 

Don’t forget to format the Group Footer #1 Subtotal for ANNUAL_SAL and the Grand 
Total in the Report Footer.  You also must move this field under the ANNUAL SALARY 
column. 

Crystal Format Painter 

The Format Painter was a new feature and icon in Crystal 10.0.  You can use it to 
copy the format from one field to others.  You cannot copy formats from Text Objects to 
Database fields or visa versa. Try using the Format Painter on the Group Total, and Grand 
Total. 

 Select the formatted ANNUAL_SAL field.  

 Click the Format Painter icon or select Format | Format Painter. 

 Click on the Sum of EMPLOYEE.ANNUAL_SAL in the Group #1 Footer. 
The object will be formatted and the Format Painter will be deactivated. 

 If you want to copy the format to both the Group #1 Total and the Grand 
Total, hold the ALT key until all objects are selected. 

 To deactivate the Format Painter, click the icon or press ESC. 

 Resize any fields if necessary.  

Tip from Databaseman: 
 
Some programmers make fields numeric that 
shouldn’t be, like phone numbers or zip codes.  You 
don’t want dollar signs, thousand separators, leading 
zeros, or decimal places in those. You can remove the 
currency formatting by using the toolbar icons. 
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 Move this field under the ANNUAL SALARY column. 
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Resizing Sections 

You will be adding a Title for this report in the Page Header. You need to make the Page 
Header bigger. The thick gray lines separating sections can be pulled down to increase the 
size of each section.   

 Place your cursor over the line dividing the Page Header from the Group 
Header #1.  It will turn into a double arrow, as shown below. 

 

 

 Hold the left mouse button down, and drag the section separator down 
about 1”.  What happens to the Field Titles? 

 To move the Field Titles back to the separator bar and over the fields 

where they belong, grab the horizontal Guide Line arrow and pull 
it down.  This moves all the objects anchored (touching the red dots) 
to the guideline at once.   
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Adding a Text Box 

You can use a Text Object as a Report Title. This does not change the name in the Title Bar, 
and does not require refreshing the report when you add or change the title. 

 Click on the Insert Text Object icon and move your cursor into 
the Page Header.  Your cursor changes into cross-hairs.   

 Draw the text box in the middle of the Page Header.  Click the left 
mouse once to anchor the frame.  

 Type the title, Employees by Region.  

 Click outside the object frame.  You are now out of text-editing 
mode.  

 Select the object and change the attribute to BOLD and the font size 
to 16.   

 Resize the text object if necessary. 

To center the text on the page: 

 Resize the text object so that it is the same size as the page width 
(LEFT to RIGHT).  

 Select the text object (if it is not already selected) and click on the 

Center icon .  The text is centered in the object and the object is 
centered on the page. 

or 

 Place a vertical guideline by clicking on the ruler at the 4-inch mark.  
An arrowhead and a vertical guideline will appear. 

 Select the text object title and click the Center Align icon .   

 Drag the title object so that the vertical midline of the object snaps to 
your centered vertical guideline.  It may take a bit of adjusting to 
place it exactly, but when you do your title will be centered between 
the margins. 
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Special Fields 

Crystal has special fields for Report Title, Page Numbers, Dates, etc. These are all listed 
under Special Fields in the Field Explorer. 

The Field Explorer 

 Click on the Field Explorer icon in the Standard Toolbar, or in 
View | Field Explorer from the Main Menu. 

The Field Explorer may be anchored on the right or left of the Design Window or Preview 
Window. You can move it from one side to the other, or detach it as a floating window. The 
floating window can also be resized. 

 

The Field Explorer contains all the fields in your report, in the Database Tables you selected 
for the Report, any Group, Formula, Running Total or Parameter fields you may have added 
to the report, and Special Fields provided by Crystal.  

 Click on the + sign next to Special Fields 
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This displays all of the Special Fields Crystal provides for use in your 
reports.   

  

Notice that Page Number and Print Date are checked. That’s because the Standard Report 
Wizard automatically adds these fields.  
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Page N of M 

If you have a report with more than one page, you might want to use Crystal’s Special Page 
N of M field.  This automatically calculates the total number of pages in your report, and 
displays the current page with the total number of pages, i.e. Page 1 of 16.  However, if you 
have a large report this will slow down producing it. 

 In the Field Explorer expand Special Fields (as shown on page 2-17). 

 Drag the Special Field Page N of M to the upper right-hand corner of 
the Page Header.   

 Delete the Page Number field from the Page Footer section. 

File Path and Name 

 

 
 Drag the Special Field File Path and Name into the lower left of the 

Page Footer. 

 Stretch the field to show the whole text. 

 Click Decrease Font Size icon, to make the text unobtrusive, 
but readable.  

 Save your Employees by Region.rpt again.  Use File | Save or click 

Save icon.   

Tip from Databaseman: 
 
Crystal has a special field for File Path and Name. 
This is useful to have somewhere on the report for 
documentation.  
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Changing a Group's Options 

When you scroll through the pages of your report, you will see a continuation of the group, 
REGION, from one page to the next, but you have to go back to the previous page to see 
which REGION it is.  You can fix this by repeating the Group Header at the top of each 
page. 

 In the Design window put your cursor into the Group #1 Section as 
shown below. 

 

 Right click and select Change Group from the popup menu. 

You will get the window shown below.  Earlier versions of Crystal used one 
dialog box, while Crystal 9 through 11 put Options on a second tab. 

 

 Click on the Options tab to go to the next window. 

Select order for group: 
 Ascending – A to Z, 0 

to 9. 
  Descending – reverse 

order. 
 Original – order used in 

database. 
 Specified – you set the 

order.   
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 Check Repeat Group Header on Each Page and click OK. 

Keep Group Together will print the group header, details and the group 
footer sections on the current page or on the next page. This can result in 
less data on each page, more pages in your report, and even blank pages. 

Customize Group Name Field allows you to create a different name for the 
Group field. 

 View report again in Preview tab.   

 Use the VCR arrows to scroll through each page.  The Group Header 
now appears at the top of each page. 
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Inserting a Field into a Text Object 

There’s only one last thing to fix on this report and it will be ready to print and deliver. The 
subtotals in the Group Footer are not very clear. 

 
 

All that’s there now is the Group Name, which is the Region Number.  This doesn’t look 
very good.  To fix this you can insert the Group Name into a descriptive Text Object. 

 Go back to the Design Window by clicking on the Design Tab 

 

 Click on the Insert Text Object icon and place your cursor in a 
blank part of the Group Footer.   

 Draw a text box and click to anchor.  

The box is now in text editing mode, and an insertion bar blinks inside the 
box.  Also, the Format toolbar that was inactive before you positioned the 
box is now active.   

 Type in Total Salaries for Region   Leave two spaces after the word 
Region. Click outside the object frame to finish your entry (do not 
press Enter).  

Pressing Enter while you are inside a text box adds a new line (like pressing 
the return key in a Word document). 

You may have to stretch the object frame to show all the words. 

Format the text to match the Group Name format. (Hint:  Click on Group 
Name field and you will see how it is formatted by the settings in the Format 
Toolbar.) You cannot format numeric fields with dollar signs or decimals 
once they are embedded in a text object.  
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You cannot use the Format Painter to copy the Group Name format to the 
Text Object, because they are different types. 

Click on the Group Name field in the Group Footer, hold down the left 
mouse button, drag the field into the Text Object and release the mouse 
button.   

When you insert the Group Name field correctly, you will see the flashing 
insertion bar in the text object two spaces from the text.  When you release 
the mouse button, your result should look like this: 

 

If you accidentally insert a field into a text object, you must immediately 

undo it.  The only other way to remove a field from a text object is to 

delete or cut it.  

 Preview the report again and see how this looks in the Group Footer. 

 Save your report again. Use File | Save or Click Save icon.  
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Formatting Borders Around Objects 

The subtotals in the report originally had lines on top and bottom.  This format is used by 
default in the Standard Report Wizard. If you used the Format Painter to format the Regional 
totals to match the Annual Salary format, these lines were removed. These were top and 
bottom borders. You can add, remove, or change borders around objects in the Format 
Editor.   

 

 Click on the Sum of EMPLOYEE.ANNUAL_SAL field (if the 
borders are still there, use the Total Salaries for Region text box). 

 Right click the mouse button and choose Format Field from the 
floating menu, or  

 Select Format | Format Field from the Menu Bar, or 

 Click on the Format icon on the Format Toolbar. 

 The Formula Editor will open on the Common Tab.  Click on the 
Border Tab. The Border dialog box is described in detail in 
Appendix B. 
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 Select Single line for top and bottom borders. 

 Click OK.  

 Save your report again. 

You can also select top and bottom borders from the Outside Borders  icon on the 
Format Toolbar, but the Format Editor gives you more choices.  

Crystal will keep the report in memory until you close the report, either by selecting File | 
Close from the Main Menu or clicking the X in the upper right corner of the report window. 
If you close your report without saving changes, you will be prompted to save it first. 

 

 

Use pull 
down list to 
select line 
format for 
border. 
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EXTRA WORKSHOP 02A – DESIGN WINDOW 

SETUP:   
 

Willy Loman is interested in the sales figures for the newly acquired company.  He needs 
50 copies of the report for the Board of Directors meeting starting tomorrow at 7:00 AM.   

This workshop uses the XTREME database, provided by Crystal. Your instructor will 
help you find it.  

 

NOTES/HINTS: 

 
Open  Crystal Standard Report Wizard. 
Connect The CUSTOMER table. 
Group by REGION. 
Create Group and 
Grand Totals 

For LAST YEAR’S SALES field. 

Center Each title using both centering methods. 
Right Align All dollar values and corresponding field heading. 
Insert Dollar signs only on group totals. 
Format  Totals to eliminate top and bottom lines. 
Insert Special Fields where appropriate. 
Change Group Keep groups together.  
Save as  WS_02 CUSTOMER SALES.RPT 
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FINISHED REPORT: 
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This page is for your notes. 


